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Unit – I  

Spreadsheet and its Business Applications 

 

A spreadsheet is a large sheet having data and information arranged in rows 

and columns. As you know, Excel is one of the most widely used spreadsheet 

applications. It is a part of Microsoft Office suite. 

 

M.S. Excel 

 

Microsoft Excel shortly known as MS Excel is one of the most popular windows 

spreadsheet program because of its power and ease of use to organize date 

about transactions for a person to examine.  It provides a grid of cell for data 

entry and a range of mathematics, financial and statistical functions to 

manipulate the data (such as sum, average and maximum values of date in 

columns or rows).  This allows the creation of business spreadsheets for sales, 

staff or product information with the associated monthly costs, sales, wages 

and profit etc.  Excel may also be used for data collection and simple statistical 

analysis in research. 

 

EXCEL WORKSHEET  

Excel allows you to create worksheets much like paper ledgers that can 

perform automatic calculations. Each Excel file is a workbook that can hold 

many worksheets. The worksheet is a grid of columns (designated by letters) 

and rows (designated by numbers). The letters and numbers of the columns 

and rows (called labels) are displayed in gray buttons across the top and left 

side of the worksheet. The intersection of a column and a row is called a cell. 

Each cell on the spreadsheet has a cell address that is the column letter and 

the row number. Cells can contain text, numbers, or mathematical formulas. 
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What can a spreadsheet do? 

In spreadsheet manipulates numerical data and text. Using a spreadsheet, one 

can create budgets, analyze data, produce financial plans, and perform 

various other simple and complex numerical applications.  By having formulas 

that automatically recalculate, either built by you, the user, or the built-in 

math functions, you can play with the numbers to see how the result is 

affected. Using this ―what-if?‖ analysis, you can see what affect changing a 

data value or calculation can have on your monitoring program.  Spreadsheets 

can also be used for graphing data points, reporting data analyses, and 

organizing and storing data. 

 

Starting Excel 

You are encouraged to start using MS Excel as you read through the following 

materials to familiarize yourself with the topics and procedures. 

1. Click the Start button on the Windows taskbar. 

a. The Start menu opens 

2. Point to Programs 

a. The Programs menu opens 

3. Click Microsoft Excel 

a. Excel opens a new workbook 

Note: an icon for MS Excel may be located either on the desktop or on the 

Office toolbar. 
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The Excel Screen 

 

 

 

Parts of Excel Windows 
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Managing worksheets 

Formatting 

 Different formats such as font, pattern, borders, colours, shading, 

numbering can be applied to the cells.  

1. Select the cells which are to be formatted  

2. Choose Cells option in Format menus. Following tabs will appear  

Font - to change font, style, size etc of a cell text.  

Border - to draw a border around a cell  

Pattern - to change the filling colour of a cell  

Alignment - to change horizontal alignment (left, right, centre), vertical  

alignment (Left to right, top to bottom) etc.  

Numbering - to change the number formats such as Date, time, 

currency, general, percentage etc.  

Increasing column width 

Move the mouse pointer to the position in the column header. When the black 

cross appears, hold down the left button and drag the mouse to the right to 

increase the column width by the required amount. 

Decreasing column width 

Move the mouse pointer to the column. When the black cross appears, hold 

down the left button and drag the mouse to the left to reduce the cell width. 

Inserting Columns 

_ Move to cell and click. 
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_ Click Insert menu, click Columns. Press Delete button. The column contents 

will be deleted. 

_ Click Undo button to revert to the previous screen. 

Inserting a row 

_ When you insert a row, it is inserted above the current row, so if 

you want to insert a new row above , place the cursor on a cell in row and 

_ Click on the Insert menu. 

_ Click Entire Rows insert a blank row between two rows.  

Deleting row contents 

_ Move the mouse pointer to row 2 header and click to select the 

row  

_ Press Delete to remove the contents of row. 

_ Click the Undo button to cancel the delete operation. 

Inserting cells 

_ Select cells B2 to D4 by moving the mouse pointer to cell B2, 

holding down the left mouse button and dragging the mouse 

pointer to cell D4, then releasing the left button. The cells should 

be highlighted. 

Click Insert menu and click Cells.  

_ Click OK to shift the cell down. 

 

Entering data is as simple as beginning to type. 

1. Click once on the cell you want to use for data entry and begin typing 

2. The following keys can be used to update the contents of the cell: Enter, Tab, 

or any of the directional arrows 

Editing data is simple as well. There are several options for doing this: 

1. Highlight the cell, type in a completely new amount (caution: this will 

overwrite any data already 

in the cell) 

2. Double-click the cell and a flashing insertion point (cursor) appears in the 

cell 
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3. Use the formula bar 

4. Highlight the cell to edit and press F2 on your keyboard 

 

Deletion of data can be relatively straightforward. You can: 

1. Select a cell or range of cells (click and hold your mouse or use the shift-

click method) and press delete 

2. Select a cell or range of cells and Edit � Clear � then choose from All, 

Contents, or Formatting from the menu bar 

3. To actually remove the cells instead of just clearing the data, select a cell or 

range of cells and Edit � Delete…; you are given the option of shifting the 

remaining cells a direction or deleting the entire row or column. Undoing an 

action can save both time and headache. In the toolbar, you will find two 

arrows. Using these arrows, you can either undo (arrow pointing left) the last 

action or series of actions you just completed, or Redo (arrow pointing right) an 

action such as formatting or deleting; you can even Redo an action that was 

undone. 

Replacing cell data 

_ Make the cell B5 active by clicking on it. 

_ Type 200 and press Enter. The cell B5 will now contain the value 

200 replacing old value (150). 

 Deleting cell contents 

_ Move to cell C5 and click to select. 

_ Press the Delete key. 

_ The cell becomes blank. 

_ Drop down the Edit menu and click Undo to reinstate the 145. 

Excel 97 allows 16 levels of undo. You can use Undo and Redo 

buttons also. 

Copying data 

_ Open the cash spreadsheet. 

_ Select the cells D3 to D5 

_ Click Edit menu and then click Copy. 
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_ Select the cells F3 to F5. 

_ Click Edit menu and then click Paste. 

_ Now the cells D3 to D5 are copied into F3 to F5. 

 Moving data 

_ Open cash.xls spreadsheet. 

_ Select the cells from B3 to B5. 

_ Click Edit menu and then click Cut. 

_ Select the cells G3 to G5. 

_ Click Edit menu and then click Paste.  

 

Printing working sheet 

Previewing a printout 

_ Open example.xls spreadsheet. 

_ Click on the File menu and click on Print Preview.  

_ Since the size of the text is very small, you can click on Zoom 

button, it magnifies the worksheet. Clicking on Zoom second 

time returns you to the original preview format. 

_ Press PgDn to move through your worksheet if it is more than 

one page long. 

_ Before printing make sure that your printer is switched on, is 

loaded with the appropriate paper, and is on-line. 

_ If you are happy with the layout of your document, click on the 

Print button to obtain a printout. You should see a message on 

screen telling you that your file is being printer, and on which 

paper. 

 

Printing landscape 

_ To select landscape mode, click on the File menu, Page Setup. 

_ Click on the Landscape button. 

 

Printing selected cells 



V. Elavazhahan, Assistant Professor/Programmer Div. Of comp. & Inf. Sci., A.U   Page 10 
 

_ Open cash.xls spreadsheet. 

_ Click on the row 2 button (or any other row containing data) to 

highlight the entire row. 

_ Click on File, Print Area, Set Print Area. The preview screen 

should only display the selected cells. (Row 2). 

_ If the preview is satisfactory, click the Print button to print out 

only row 2. 

_ Click on File, Print Area, Clear Print Area to reset the Print Area. 

 Formula & Functions 

 Functions are typed in a cell in following format=Function name(argument) 

Argument may be in any one of the following format.  

1. Numeric value  

2. Cell address  

3. Range ( Starting cell address : Ending cell address)  

4. Range name  

5. Cell addresses (Address1, address2, .....)  

Functions are classified into several functions such as  

1. Math & Trig function  

2. Text function  

3. Logical function  

4. Statistics function  

5. Lookup and reference function  

6. Date & Time function  

7. Financial function  

8. Information function  

9. Data base function  
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Statistical functions  

Count() - count number of numeric values in a list. Other type data will be included (1 

to 30 arguments)  

CountA() - count the nonempty cells in a range  

Min() - find the minimum value in a range  

Max() - find the maximum value in a range  

Var() - find variance of the range  

Stdev() - find standard deviation of the range  

Mode() - find the most common value in a range  

Median() - find the median of the range  

Financial Functions 

1. DDB() - calculate depreciation using double declining method  

2. FV() - calculate future value of an investment  

3. PMT() - calculate periodic payment value  

4. PV() - calculate present value  

5. SLN() - calculate depreciation using straight line method  

6. SYD() - calculate depreciation using sum of years  

Organizing Chart and graphs 
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 Numeric data can be summarised into charts such as line chart, bar chart, pie chart 

etc. Bar chart and Line chart can be used to show the relationship of multiple data. Pie 

chart shows the relation of a single data. In excel, data can be easily converted into chart. 

Chart can be drawn in the same worksheet or in a new work sheet. Following steps are 

followed to draw a chart  

1. Select the data series range  

2. Choose Chart option in Insert menu and select On New sheet or On this sheet.  

3. If On this sheet is selected, specify the area where the chart is to be drawn  

4. Verify the selected series range  

5. Choose the type of chart such as pie chart, bar chart etc  

6. Give the title of chart, X axis title, Y axis title.  

7. If the legend is to be displayed, choose Show legend and choose Finish button  

After drawing chart, we can change the type of chart by clicking the type tool in 

chart toolbar.  

Changing Size of the Chart 

1. Click the chart  

2. Drag the corner walls till the desired size is obtained  

Moving Chart 

1. Click the chart  

2. Drag the chart till the desired location is reached  

A. BAR CHART: 

 

1. Click chart group from insert tab. 

2. Select bar chart and click next. 

3. Click data range box. 



V. Elavazhahan, Assistant Professor/Programmer Div. Of comp. & Inf. Sci., A.U   Page 13 
 

4. Click data on work sheet to designate data which we want   to 

pallet. 

5. Click next and type chart file, x axis file and y axis title select and 

enter data. 

6. Click next data labels tab appears and enter data. 

7. Click next and data table tab appears and click show data table. 

 

B. COLUMN CHART: 

 
1. Click chart group from insert tab. 

2. Select column chart and click next. 

3. Make all data click finish. 

 

C. PIE CHART: 

 

1. Click chart group from insert tab. 

2. Select pie chart and click next. 

3. Make all data and click finish. 

 

D. LINE CHART: 

1. Click chart group from insert tab. 

2. Select line chart and click next. 

3. Make all data and click finish. 

E. X Y SCATTERED CHART: 

1. Click chart group from insert tab. 

2. Select scattered chart and click next. 

3. Make all data and click finish 

F. AREA CHART: 

 

1. Click chart group from insert tab. 

2. Select area chart and click next. 

3. Make all data and click finish. 
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Loan A/c Spreadsheet 

1. Summary. ... 

2. Get the periodic payment for a loan. 

3. loan payment as a number. 

4. =PMT (rate, nper, pv, [fv], [type]) 

5. rate - The interest rate for the loan. ... 

6. The PMT function can be used to figure out the future payments for a loan, 

assuming constant payments and a constant interest rate. 

 

How to Calculate a Monthly Loan Payment in Excel (Mortgage, Car Loan, 

and More) 

Excel has a function automatically built into the program that calculates 

monthly payments for you. All you need to do is enter the specifics of the loan 

and you can calculate monthly payments for mortgages, car loans, student 

loans, and more. 

Below we walk you through exactly how to calculate your monthly loan 

payment using Excel. If you would rather, Investing Answers also has a 

number of calculators that can figure your payments for you. 

Calculating Monthly Payments with Excel (All Versions) 

To calculate a monthly payment for a loan using Excel, you will use a built-in 

tool called "PMT, " or the "Payment" function.  

The PMT function works the same across all versions of Excel, so the 

instructions below will work no matter if you are running an old or brand-new 

edition of the program. 

https://investinganswers.com/calculators
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The PMT function requires three data points to calculate a monthly loan 

payment -- the interest rate, the number of loan payments, and the amount 

borrowed.  

 RATE Required: Interest rate of the loan 

 NPER (number of periods) Required: The number of loan payments 

 PV (present value) Required: The amount borrowed 

There are two other optional data points you can use for your specific 

calculation, should they be needed: 

 FV (future value) Optional: The final balance after all payments are made 

(usually $0) 

 TYPE Optional: Use "0" or "1" to specify whether the payment is timed at 

the beginning or end of the month (assuming the loan payments are 

made monthly). 

To use the PMT function, you will select the cell and type in "=PMT(" without 

the quotation marks. It will then begin asking you to enter in the following 

additional data points: 



V. Elavazhahan, Assistant Professor/Programmer Div. Of comp. & Inf. Sci., A.U   Page 16 
 

 

RATE: After typing the open parenthesis, Excel will first ask for the RATE, or 

interest rate on the loan. Here you will enter the interest rate in percentage 

terms for each period. So if you want to calculate a monthly mortgage payment 

using a 5% interest rate, you can enter "5%/12" or "0.05/12". The "/12" divides 

the annual interest rate into monthly amounts. (Caution:  If you just enter 

"5/12" instead, then Excel will interpret this as a 500% annual rate paid 

monthly. Entering just "5" will result in a 500% interest rate each month.) 
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NPER: Once you enter the interest rate, type a comma to move to the next data 

point, NPER, or number of periods. This is simply how many payments you will 

make on a loan. For example, a 30-year mortgage paid monthly will have a 

total of 360 payments, so you can enter "360" or "30*12". If you wanted to 

calculate a five-year loan that's paid back monthly, you would enter "60" or 

"5*12" for the number of periods. 

PV: For the PV (present value) data point, you will enter the amount borrowed. 

For example, if you have borrowed $150,000, you will enter "150000" into this 

section.  

FV: Using the FV (Future Value) data point is optional. It usually comes into 

use if you are calculating a savings goal instead of paying down a loan balance. 

Since the vast majority of loans are based on paying the loan off completely, 

this is automatically defaulted to $0 for the PMT function. If you are instead 

saving money for a goal, then you can enter "0" for the PV and the balance you 

want after the last payment for the future value.  

TYPE: Finally, using the TYPE data point you can specify whether the loan 

payments occur at the beginning of each period or at the end. The timing of the 

payment has an impact on the amount of interest accrued during the month.  

Note: While you can enter each data point separately, it's usually better to 

have a cell dedicated to each figure as we do in the examples below. That way 

you can adjust your data within the cells easily to see how the monthly 

payment changes. 

Example: Calculating a Monthly Mortgage Payment in Excel 

Let's say you are shopping for a mortgage and want to know what your 

monthly payment would be. To calculate, all you need are three data points: 

 Interest rate 
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 Length of loan 

 The amount borrowed 

We've inserted example data points below. Here, we are calculating the monthly 

payment for a 30-year mortgage of $250,000 at an interest rate of 5.0%: 
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To calculate our payment, we enter this data into the appropriate field in the 

PMT function. Note that because our mortgage is based on monthly payments, 

we will divide the interest rate by 12 (to give us the monthly interest rate) and 

multiply the number of payments by 12 (to give us the total number of 

payments):  
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As you can see below, the monthly principal and interest payment for this 

mortgage comes out to $1,342.05. This is shown in Excel as a negative 

figure because it represents monthly money being spent. If you wanted to show 

it as a positive figure, you can enter a negative sign in front of the amount 

borrowed. 
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Lease A/c  

Monthly Lease Payment 

A Lease contract is a written agreement between two parties that identifies the 

terms of the lease as well as the leased property.  The leased property‘s owner 

is called the lessor, and the company renting the property is considered the 

lessee. 

The most common Items found in a lease contracts are 

1. The name of the lesser and lessee 

2. The name and description of the leased property 

3. Specific lease payment and times 

4. Penalties for late payment 

5. Contract duration 

6. Ending buyout agreement. 

What does it do? 

This monthly lease payment calculator works out the monthly payment (Pmt) 

needed at the end of each month, taking into account the cost of the asset (C), 

its residual value (R), the lease interest rate (i), the number of payments (n), 

and the number of advance payments (a) required by the lease agreement. 

A lease is a method of financing the use of an asset, and is an agreement 

between a lessee (who rents the asset), and a lessor (who owns the asset). The 

lessor is usually a lease company or finance company. 

ease Calculator Formula 

The calculator uses the monthly lease payments formula based on the present 

value of an annuity as follows: 
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Pmt = (C + R/(1 + i)n) x (i/((a x i) + (1 - 1/(1 + i)(n-a)))) 

Variables used in the formula 

Pmt = Periodic lease payment 

i = Lease interest rate 

n = Number of lease payments required by the lease agreement 

a = Number of payments made in advance 

C = Original cost of the asset 

R = Residual value of the asset (negative number) 

Monthly Lease Payment Calculator Instructions 

The Excel monthly lease payment calculator, available for download below, 

computes the monthly lease payment by entering details relating to the cost 

and residual value of the asset, the lease interest rate, and the number of 

payments and advance payments required by the lease agreement. Instructions 

for using the calculator are as follows. 
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Step 1 

Enter the asset cost (C). This is the amount the lessor (finance company) pays 

for the asset today, at the start of the lease term. 

Step 2 

Enter the residual value (R). This is residual or salvage value of the asset at the 

end of the lease term. The residual value (R) should be entered as a negative 

number. For example, if the residual value is 3,000 enter -3,000. 
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Step 3 

Enter the interest rate. The interest rate should be the annual interest rate 

used in the lease agreement. The monthly lease repayment calculator works 

out the monthly rate (i). 

Step 4 

Enter the number of payments (n). This is the total number of monthly 

payments required by the lease. For example, if the lease has a 3 year term, the 

number of payments (n) will be 3 x 12 = 36 monthly lease payments. The total 

number of payments includes the advance payments referred to below. 

Step 5 

Enter the number of payments in advance (a). This is the number of monthly 

payments required to be paid in advance (today) at the start of the lease 

agreement. For example, if the total number of payments (n) is 36, and the 

number of advance payments (a) is 2, a further 34 payments will be made at 

the end of each month for the following 34 months. 

Step 6 

The monthly lease payment calculator works out the periodic payment (Pmt) 

required. 
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Preparing Payroll Statement in excel sheets 

To create a spread sheet or worksheets in ms excel and give your own 

data from a graph. 

 
HRA is 18% OF BASIC 

DA is 15% OF BASIC 

TA IS 12% OF BASIC 

PF IS 10% OF BASIC 

GPF IS 5% OF BASIC 

LIC IS 7% OF BASIC 

GROSS SALARY =BASIC + HRA + DA+TA 

DEDUCTION = PF+GPF+LIC 

NET SALARY = GROSS SALARY - DEDUCTION 

 
A. Bar graph  

B. Column chart  

C. Line chart  

D. Area chart  

 

PROCEDURE: 
 

Click sheet two to display corresponding work sheet at the bottom of the 

work sheet  

Type the following data and select data: 

 
1. For HRA put the cell pointer in C2 and press = (equal to) for entering the 

formula. Choose the B2 cell (Basic salary) and type *(multiplication 

operator) and type 18% then press enter. Now the 18% HRA from basic is 

calculated. 

2. Then drag that formula for entire records. 
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3. For DA put the cell pointer in D2 and press = (equal to) for entering the 

formula. Choose the B2 cell (Basic salary) and type *(multiplication 

operator) and type 15% then press enter.  

 

4. Now the 15% DA from basic is calculated. Then drag that formula for 

entire records. 

 

5. Follow the above steps for calculation of TA, PF, GPF, and LIC. 

 

6. For GS(gross salary) put the cell pointer in I2 and choose the =( equal to), 

then click on B2cell + click on C2+ click on D2+ click on E2 and press 

enter. Now the gross salary was calculated. 

 

7. Drag the entire cell. 

 

8. Follow the above step for deduction and net salary calculations. 
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GRAPH 

 

 

A. BAR CHART: 

 

1. Click chart group from insert tab. 

2. Select bar chart and click next. 

3. Click data range box. 

4. Click data on work sheet to designate data which we want   to 

pallet. 

5. Click next and type chart file, x axis file and y axis title select and 

enter data. 

6. Click next data labels tab appears and enter data. 

7. Click next and data table tab appears and click show data table. 
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B. COLUMN CHART: 

 

1. Click chart group from insert tab. 

2. Select column chart and click next. 

3. Make all data click finish. 

 

C. LINE CHART: 

 

1. Click chart group from insert tab. 

2. Select line chart and click next. 

3. Make all data and click finish 

 

D. AREA CHART: 

 

1. Click chart group from insert tab. 

2. Select area chart and click next. 

3. Make all data and click finish. 
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BAR CHART 

 
 
COLUMN CHART  
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Capital Budgeting 
 
Capital budgeting and investment appraisal is the planning powers used to 

determine whether are organization‘s long term investments such as new 

machinery, replacement of machinery, new plants, new products and new 

research development projects are worth the funding of cash through the firm‘s 

capitalization structure. 

 

Calculating the NPV and IRR of a Project Investment 
The Capital Budgeting-Project Cash Flow-NPV worksheet in the Capital 

Budgeting spreadsheet allows you to key in the assumptions and estimates of a 

project cash flow and will calculate the Net Present Value and Internal Rate of  

Return of the investment. 

 

Assumptions 

This worksheet performs capital budgeting analysis by making three basic 

assumptions. The assumptions are the Discount Rate to use in the investment 

project, the company's Tax Rate and the estimated percentage of Net Working 

Capital over Sales. 
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Projected Income 

 
The net income of the project is calculated by using the following formula: 

 
Net income = Earnings before Interest & Taxes (EBIT) - Taxes 
 

 
where 
 

EBIT = Net Sales - Total Variable Costs - Total Fixed Costs - Depreciation 
 

 

 
 
 

Projected Cash Flows 
 
This section is where the estimated cash flows are calculated. The Operating 

cash flow is defined as follows: 
 

Operating cash flow = EBIT + Depreaciation + Taxes 
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Net Working Capital 

The Net Working Capital at Year 0 can be entered directly into the spreadsheet. 

From Year 1 onwards, it is calculated as as function over Net Sales as follows: 

 

Net Working Capital = Net Working Capital over Sales * Net Sales 

 

Net Working Capital cash flow is calculated as follows: 

 

Net Working Capital cash flow = -(Current Year Net Working Capital - Previous 

Year Net Working Capital) + NWC Recovery at end 

 

Investment (Capital Spending) 

The project investment and salvage value are taken into account in this 

section. 

 

Aftertax salvage value is calculated as follows: 

 

Aftertax salvage value = Salvage value * (1 - Tax Rate) 
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Net Capital Spending is calculated as follows: 

 

Net Capital Spending = Initial Investment + Aftertax salvage value 

 

Project Total Cash Flow 

The Discounted cash flow uses the Time Value of Money to discount the Total 

project cash flow with the assumed Discount Rate. Total project cash flow is 

calculated as follows: 

 

Total project cash flow = Operating cash flow + Net Working Capital cash flow + 

Net Capital Spending 

 

Net Present Value and Internal Rate of Return 

 

Net Present Value is calculated using Excel's NPV function on the Total project 

cash flow. Internal Rate of Return is calculated using Excel's IRR function on 

the Total project cash flow. 

 

Depreciation Account 

Definition: The monetary value of an asset decreases over time due to use, 

wear and tear or obsolescence. This decrease is measured as depreciation. 

 

Description: Depreciation, i.e. a decrease in an asset's value, may be caused 

by a number of other factors as well such as unfavorable market conditions, 

etc. Machinery, equipment, currency are some examples of assets that are 

likely to depreciate over a specific period of time. Opposite of depreciation is 

appreciation which is increase in the value of an asset over a period of time. 

 

Accounting estimates the decrease in value using the information regarding the 

useful life of the asset. This is useful for estimation of property value for 
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taxation purposes like property tax etc. For such assets like real estate, market 

and economic conditions are likely to be crucial such as in cases of economic 

downturn. 

Excel offers five different depreciation functions. We consider an asset with 

an initial cost of $10,000, a salvage value (residual value) of $1000 and a 

useful life of 10 periods (years). Below you can find the results of all five 

functions. 
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Most assets lose more value in the beginning of their useful life. The SYD, DB, 
DDB and VDB functions have this property. 
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SLN 
The SLN (Straight Line) function is easy. Each year the depreciation value is the same. 

 

The SLN function performs the following calculation. Deprecation Value = 

(10,000 - 1,000) / 10 = 900.00. If we subtract this value 10 times, the asset 
depreciates from 10,000 to 1000 in 10 years (see first picture, bottom half). 
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=SLN(COST,SALVAGE,LIFE)  =>  Straight line function,  

=SYD(cost,salvage,life,A9)  => sum of years‘ digits 

= DB(cost,salvage,life,A9) => Declining Balance 

=DDB(cost,salvage,life,A9) => Double Declining Balance 

=VDB(cost,salvage,life,A9) = Variable Declining Balance 

Frequency distribution and its statistical parameters : 

Correlation Regression 

(1) Mean  

(2) Standard deviation  

(3) Variance 

(4) Correlation 

(5) Histogram 

(6) Regression 

(7) Sampling 

 
PROCEDURE: 

 
1. Select insert function command. 

2. Click the desired function in the name to see the function arguments 

and description of the functions. 

3. Double click the desired function command, to display the function 

and its arguments in the formula. 

4. As we create the formula, the formula pallet will assist us. Then it 

returns the result. 

A) MEAN:  
Mean‘s the average of all the given data. 

Syntax:  Average (Num 1, Num 2 …) 

        E.g. If A1 … A5 is named scores and contains the number 10, 7,9,27 and  

  27 then  

Average (A1:A5) =11 
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B) STANDARD DEVIATION: 

 
Standard deviation is a measure how widely values are dispersed 

from average value.  

                  

Syntax: STDEV (num 1, num 2…) 

 

STDEV assumes that its arguments are a sample of population. If 

your data represents the entire population then comp STDEV using 

STDEV in the following formula. 

 

E.g. The sample values (1345, 1301, 1368, 1322, and 1310)  

are stored (A2: E3)  

STDEV (A2:E3) =27.25 

 
 

C) VARIANCE:  
 

         Estimates variance based on a sample  

               

Syntax: VAR (Num 1, Num 2) 

 

VAR Assumes that its argument are a sample of population VAR uses the 

following formula. 

 

E.g. Input values: 1345, 1301,1368,1322,1310, are stored in 

 A2: E3 

VAR (A2:E3) =742.7 

 

  



V. Elavazhahan, Assistant Professor/Programmer Div. Of comp. & Inf. Sci., A.U   Page 39 
 

D) CORRELATION: 
 

Returns the correlation co efficient of the array 1 and array 2. Cell 

ranges use the correlation co efficient to determine the relationship 

between the proper lines. 

 

            Syntax: CORREL (Array 1, Array 2) 

Array 1 is the first cell range of values.= {2,4,5,6,}   

Array 2 is the second cell range of values. { 9,7,12,17 } 

         = CORREL(A1:A4,B1:B4)  equals  0.751671 

 

E) REGRESSION:  

Trend lines are used to graphically display trends the data and to 

analyze problems of prediction. Such analysis is also called regression 

analysis. Using regression analysis are can extend bend in a chart 

beyond the actual data to predict future values. 

 
F) SAMPLING:  

The process of selecting a sample from a population is called 

samplings. There are 2 types  

  

                    1. Periodic sampling                              2. Random sampling.  

G) HISTOGRAM 

The Histogram analysis tool calculates individual and 

cumulative frequencies for a cell range of data and data bins. This 

tool generates data for the number of occurrences of a value in a data 

set. 

1. Enter your data in to the worksheet. 

2. On the Data tab, click Data Analysis in the Analysis group. 
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3. In the Data Analysis dialog box, click Histogram, and then click OK. 

 

 

 

4. In the Input Range box, type the input range. 

 

 
 

5. In the Bin Range box, type the bin range. 
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6. Under Output Options, click Output Range and give the output cell   

range, select the Pareto (sorted histogram), Cumulative percentage, 

Chart Output check box, and then click OK. 
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Unit –II 

Preparing Presentations 

MS-PowerPoint 

Power point is presentation software program.  Power point uses a graphical 

approach to presentation in the form of slide shows that accompany the oral 

delivery of the topic. 

This program is widely used in business and classrooms and in an effective tool 

when used for training purposes. 

Powerpoint Facility 

1. Powerpoint is one of the sumplest computer programe to learn 

2. It is easy and good program used world wide for presentations 

3. It is easey to customize presentations with company logo. 

4. Many more templates are also available, the user can utilize the templates. 

5. In addition to an on screen slide show 

6. Power point has printing option. 

7. Powerpoint is one of the sumplest computer programe to learn 

8. It is easy and good program used world wide for presentations 

9. It is easey to customize presentations with company logo. 

10. Many more templates are also available, the user can utilize the templates. 

11. In addition to an on screen slide show 

12. Power point has printing option. 

 

Presentation 

A presentation in a collection of data and information that is to be delivered to a 

specific audience. 



V. Elavazhahan, Assistant Professor/Programmer Div. Of comp. & Inf. Sci., A.U   Page 43 
 

A power point presentation is a collection of electronic slides that can have text, 

picture, tables, sound and video.  This collection can run automatically or can be 

controlled by a presenter. 

Function of power point 

It is commonly used in a variety of ways by business, education, and government 

employees to provide a computerized, “Slide-show” for enhance the 

presentation.  Power point might be employed to direct attention to an outline of 

the presentation or display graphs and pictures or to focus the audience on key 

points. 

Features of Microsoft power point: 

1. Start with a bulid in layout 

2. Use slide master view to update design consistently  

3. Use some one else’s presentation as a starting point 

4. Rearrange slides for effectiveness 

5. Follow the guides 

6. Set slide sizes 

7. Resize multiple objects 

8. Clean up tables quickly  

9. Learn to use smart art 

10. Try a theme variance 

 

Start with a built in Layout 

There are really two directions you can go when you are building out a new slide  in 

MS power point 

1. Design the slide from scratch, dropping in individual place holder boxes one 

after another, adding them one by one until you have got a slide 
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2. Try out a built-in layout that includes all of the content boxes that you need 

from the beginning. 

a. It‘s really a no-brainer to start your slide design with a pre-built layout. 

b. It is a time saver and it also imporves the look of the presentation because 

all boxes and contains are aligned neatly. 

3. Use slide master view to update design consistently.  Not only save time, but 

also ensure that slides are consistent. 

It‘s huge advantage if the logo is in the same spot on each slide.  For example, 

slide masters control the design for multiple slides at the same time,  when you 

adjust a slide master, each slide that uses that master will have the same 

changes. 

Example : Go to the view tab and choose slide master.  Now, add something 

that you want to appear on each slide (like a logo or footer text) to the master. 

 When you return to normal view, wewill see the changes on each slide 

that used the same master. 

 

Components of MS-Power Point 

1. User interface – The most visible element of power point is its user interface 

the screen dialog boxes, buttons, panes and other parts of the application 

window. 

2. Slides : The slide is the power point element on which you insert test, 

graphics, audio, video and animations 

3. Content: Power point contest type include static text and graphics audio, 

video and animation created inside power point itself. 

4. Formatting :  Formatting with which we decorate the content on slides.  

Such as Bold – Align Text- Design. 

5. Presentation play box : Create a self running presentation 

 

Slide layout types 

1. Title slide 

2. Title and content 

3. Section header 

4. Two Content 
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5. Comparision 

6. Title only 

7. Blank 

8. Conten with caption 

9. Picture with caption 

Template  

A template is a file that serves as a starting point for a new document. When you open 

a template, it is pre-formatted in some way. For example, you might use template in 

Microsoft Word that is formatted as a business letter. The template would likely have a 

space for your name and address in the upper left corner, an area for the recipient's 

address a little below that on the left site, an area for the message body below that, 

and a spot for your signature at the bottom. 

When you save a file created with a template, you are usually prompted to save a copy 

of the file, so that you don't save over the template. Templates can either come with a 

program or be created by the user. Most major programs support templates, so if you 

find yourself creating similar documents over and over again, it might be a good idea 

to save one of them as a template. Then you won't have to format your documents 

each time you want to make a new one. Just open the template and start from there. 

 

Animation 

Computer animation is a general term for a kind of visual digital display 

technology that simulates moving objects on-screen. Modern forms of computer 

animation evolved from more primitive computer graphics over the last few 

decades, as huge advances in computer technology led to much more 

sophisticated imaging methods. Modern computer animation can achieve 

dazzling results with three-dimensional figures acting against a three-

dimensional background. As a result, it has largely revolutionized the film 

industry by reducing the costs associated with setting up physical film sets, 

hiring extras and gathering props. Now, many of these physical assets can be 

simulated using computer animation. 

The simplest and earliest forms of computer animation simply moved objects 

around on a screen in what's called two-dimensional computer graphics 



V. Elavazhahan, Assistant Professor/Programmer Div. Of comp. & Inf. Sci., A.U   Page 46 
 

animation. These kinds of technology are still common, for example, in 

animated GIF files. Early old computer systems could achieve these kinds of 

animation, which gradually developed into more sophisticated forms where pre-

drawn images were juxtaposed on moving backgrounds to simulate an 

elaborate animation reel. 

Today's computer animation, also called computer-generated imagery (CGI) 

animation, uses three-dimensional methods involving digitally produced pieces 

placed onto a conceptual "skeleton" or other framework. CGI may refer to static 

or animated content, whereas computer animation specifically refers to 

displays of objects in motion. 

 

Transitions 

When referring to video or a slide a transition is an effect that happens 

between each photo, slide, or video clip. For example, a fade transition can be 

used to fade in or out of each picture in a slide show. 

Changing the transitions in Microsoft PowerPoint 

 

The transitions can be adjusted in Microsoft PowerPoint by clicking on the 

Transitions tab. Once in the Transitions section, you'll see each of the available 

Transition and can click the down arrows to scroll through and view all 



V. Elavazhahan, Assistant Professor/Programmer Div. Of comp. & Inf. Sci., A.U   Page 47 
 

available Transitions. Clicking on any of the transitions give you an overview of 

the transition. Clicking on Effect Options allows you to change the direction 

or other options of the effect. Sounds allow you to have a sound on each 

transition. Duration allows you to increase or decrease the duration or time of 

the effect. 

Examples of different types of transitions 

There are dozens of types of transitions that can be used in most programs. 

Below is an alphabetical listing of different types of transitions and what type 

of animation or effect they give your show. Keep in mind that not all of the 

below transitions will be available in every program that supports transitions. 

 Blinds - Horizontally or vertically flip over bars like slats in blinds to 

reveal next scene. 

 Box - Show overview of current scene and rotate it as if it were inside a 

box to show next scene. 

 Checkerboard - Flip over checkerboard tiles to reveal next scene. 

 Clock - Reveal next scene in a clockwise or counterclockwise reveal. 

 Conveyor - Move current scene off screen while bringing in next scene 

like a conveyor belt. 

 Cover - Reveal an overview and then flip the next scene on top of the 

previous. 

 Cube - Show overview of current scene and rotate it as if it was an edge 

of a cube to next side to show next scene. 

 Cut - Quick cut to next scene. 

 Dissolve - Dissolve previous scene to reveal next scene. 



V. Elavazhahan, Assistant Professor/Programmer Div. Of comp. & Inf. Sci., A.U   Page 48 
 

 Doors - Split the current scene and open it as if it were a door to reveal 

next scene. 

 Fade - Fade (dissolve) in our out. 

 Ferris Wheel - Rotate out current scene followed by next scene in a 

circular motion like a Ferris wheel. 

 Flash - Camera flash effect to display next scene. 

 Flip - Show overview of current scene and flip it around to show next 

scene on its back. 

 Fly through - Fly through the current scene to show next scene behind 

current scene, like zoom effect without removing background. 

 Gallery - Show overview of current slide and move to next scene as if you 

were looking at art in a gallery. 

 Glitter - Dissolve and reveal next slide in an octagon glitter effect. 
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Unit III 
Introduction to Accounting Package Tally 

 

Financial accounting Packages- Introduction 

Financial accounting is the process of preparing financial statements that 

companies‘ use to show their financial performance and position to people 

outside the company, Including investors, creditors, suppliers, and customers. 

Financial accounting package generates the following financial statements: 

1. Income statement (sometimes referred to as earnings statement" or 

"profit and loss [P&L] statement") 

2. Statement of comprehensive income 

3. Balance sheet (sometimes referred to as "statement of financial position") 

4. Statement of cash flows (sometimes referred to as "cash flow statement") 

5. Statement of stockholders' equity 

Income Statement 

The main components of the income statement are revenues, expenses, gains, 

and losses. Revenues include such things as sales, service revenues, and 

interest revenue. Expenses include the cost of goods sold, operating expenses 

(such as salaries, rent, utilities, advertising), and non operating expenses (such 

as interest expense).  

Statement of comprehensive income 

The statement of comprehensive income covers the same period of time as the 

income statement, and consists of two major sections: 

 Net income (taken from the income statement) 

 Other comprehensive income (adjustments involving foreign currency 

translation, hedging, and postretirement benefits) 

The sum of these two amounts is known as comprehensive income. 
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Balance Sheet 

The balance sheet is organized into three parts: (1) assets, (2) liabilities, and (3) 

stockholders' equity at a specified date (typically, this date is the last day of an 

accounting period). 

The first section of the balance sheet reports the company's assets and 

includes such things as cash, accounts receivable, inventory, prepaid 

insurance, buildings, and equipment. The next section reports the 

company's liabilities; these are obligations that are due at the date of the 

balance sheet and often include the word "payable" in their title (Notes Payable, 

Accounts Payable, Wages Payable, and Interest Payable). The final section 

is stockholders' equity, defined as the difference between the amount of assets 

and the amount of liabilities. 

Statement of Cash Flows 

The statement of cash flows explains the change in a company's cash (and cash 

equivalents) during the time interval indicated in the heading of the statement. 

The change is divided into three parts: (1) operating activities, (2) investing 

activities, and (3) financing activities. 

The operating activities section explains how a company's cash (and cash 

equivalents) have changed due to operations. Investing activities refer to 

amounts spent or received in transactions involving long-term assets. 

The financing activities section reports such things as cash received through 

the issuance of long-term debt, the issuance of stock, or money spent to retire 

long-term liabilities. 

Statement of Stockholders' Equity 

The statement of stockholders' (or shareholders') equity lists the changes in 

stockholders' equity for the same period as the income statement and the cash 

flow statement. The changes will include items such as net income, other 

comprehensive income, dividends, the repurchase of common stock, and the 

exercise of stock options. 
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Financial Reporting 

Financial reporting is a broader concept than financial statements. In addition 

to the financial statements, financial reporting includes the company's annual 

report to stockholders, its annual report to the Securities and Exchange 

Commission (Form 10-K), its proxy statement, and other financial information 

reported by the company. 

Computerized accounting software is used for evaluating the profitability and 

financial performance of different organizations. Manual accounting has 

become redundant nowadays, as they are prone to human error. Thus, 

businesses of all sizes rely on the best accounting software in India to make the 

complex accounting task more manageable and error-free. 

Features of Computerized Accounting Software 

A robust accounting software solution is capable of taking your business to 

new heights of success. 

 Invoicing: This is the basic module of all accounting software that 

automates the process of collections so that you never forget to send 

out an invoice. An invoicing system stores all customer data and also 

generates accurate invoices for clients on time, besides reminding them 

about outstanding bills.  

 Reporting: Software for computerized accounting features a broad array 

of reporting options such as balance sheet, income statement 

highlighting your profit and loss, cash flow statement, payroll 

summary, and so on.   

 Banking: Computerized accounting software keeps track of your banking 

accounts and also imports data from your bank into the system.  Its 

automatic payment module prints checks, and schedules bank payments 
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and direct deposits, thus, automating your bank payment processes. 

 

 Budgeting and Forecasting: A good tool calculates and depicts your 

financial performance for the current and upcoming fiscal year. It 

generates balance sheet summaries to portray how well your business 

is performing at the moment so that you can set up realistic sales 

targets. 

 

 Inventory Management: An efficient billing software solution also 

manages your stock; this helps you keep tabs on the availability of 

your products so that you can quickly deal with delivery issues. 

 

 Payroll: Some software also comes with sophisticated payroll modules 

for managing all aspects of payroll. This module enables you to 

generate employee payments and process their checks on time. It also 

simplifies the process of managing variable pay schedules along with 

bonuses, commissions, profit-sharing, etc.  

 Fund Accounting: Accounting system designed for NGOs and public 

agencies come with fund accounting module for grant management, 

tracking donations, and managing GASB regulations. 

 Ability to Collaborate: Computerized billing systems enable you to 

authorize contractual accountants to access your financial data. You 

can easily synchronize your data with your bank account and import 

your financial reports in seconds. 

 Multi-functionality: If you are operating your business globally, you 

might know how difficult it is to manage finances across multiple 

currencies. However, with the right invoicing solution, you can make 

the process of accumulating data from multiple business locations 

much easier. An efficient billing software solution is also capable of 

recording and delineating financial dealings in multiple currencies. 
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Advantages of Computerized Accounting System 

Computerized Accounting Software streamlines accounting tasks and offers 

several benefits to its users. It not only automates your accounting tasks but 

also helps you chalk out a results-driven investment strategy. Here are the top  

of using such a solution: 

 Mobility: Being cloud-based, automated billing software allows you to 

access your financial accounts from anywhere. Apart from supporting 

web browsers, advanced billing applications come with a mobile 

interface to enable you to manage daily accounting tasks such as 

expense tracking, attaching receipts, viewing invoice information, or 

sending bills directly from your iOS and Android devices. It also helps 

you stay connected with your clients and accounts team on the go. 

 Speed: Computerized Account Software is known for its swiftness. Once 

you input data into a connected module, it processes and stores the 

information instantaneously. 

 Cost-effective: Hiring an in-house accountant can be quite expensive for 

small business owners. Once you decide to deploy a computerized 

billing system, you can use the program after undergoing a customer 

training program to derive the maximum benefit from the software. 

What‘s more, you need to pay only for purchasing and installing the 

software and an occasional software upgrade. 

 Saves Time: Compared to the time-consuming manual process of 

accounting, computerized accounting system saves your time, and 

boosts your productivity. The software is capable of performing 

accounting functions faster than manual accounting. It centralizes the 

financial aspects of your business and enables you to deal with 

different accounting tasks within one unified accounting platform. 
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 Reliability: Computerized billing solution generates financial statements 

and reports with precision and consistency. Thus, you can completely 

rely on it. 

 

 Reduces Human Errors: Computerized accounting system reduces 

errors, and eliminates the need for manually checking your accounts 

each time you input new data. Minimization of inaccuracies also makes 

this software more dependable. 

 Offers Real-Time Data: The software can be synchronized with your 

online banking account. As a result, you always receive real-time 

information on paid invoices as well as your business expenditures. 

 Lightning-fast Decision Making: Since computerized accounting 

solutions provide real-time financial information, it helps you make 

smarter financial decisions at lightning speed. 

 Security: Computerized billing software comes with sophisticated 

security mechanisms to protect sensitive financial data. It keeps your 

financial data, passwords, and other information safe and confidential. 

 Helps You Allocate Resources the Right Way: It is one of the key 

advantages of using this platform. It is important to comprehend the 

pattern of your financial performance to run your company 

advantageously. Computerized accounting system acts as your 

financial advisor, and gives you a clear overview of your financial 

activities, thus, helping you determine where to invest more, and where 

to cut costs. 

 

 Simplifies Tax Compliance: Automated accounting software system 

gives you a quick overview of the amount of taxes that your company 

has paid till date. It also computes the amount of tax that you or your 

clients need to pay on each invoice. 
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Introduction to Tally 

Tally is powerful accounting software. It is easy to use software and is designed 

to simply complex day to day activities associated in an enterprise. Tally 

provides comprehensive solution around accounting principles, inventory and 

data integrity. Tally also has feature encompassing global business. Tally 

software comes with easy to use interface thus making it operationally simple. 

Tally accounting software provides a solution around inventory management, 

stock management, invoicing, purchase order management, discounting, stock 

valuation methodology, etc. 

Tally accounting software also comes with drill down options, which can track 

every detail of transaction. It helps in maintaining simple classification of 

accounts, general ledger, accounts receivable and payable, bank reconciliation, 

etc. 

The technology employed by tally makes data reliable and secure. Tally 

software supports all the major types of file transfer protocols. This helps in 

connecting files across multiple office locations. 

Tally accounting software is capable of undertaking financial analysis and 

financial management. It provides information around receivables turnover, 

cash flow statement, activity consolidation and even branch accounting. 

Tally accounting software is easy to set up and simple to use. A single 

connection can support multiple users. It can be easily used in conjunction 

with the Internet making possible to publish global financial reports. 

Features of Tally   

A leading accounting package: The first version of Tally was released in 1988 

and, through continuous development, is now recognised as one of the leading 

accounting packages across the world, with over a quarter million customers.  
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No accounting codes: Unlike other computerised accounting packages which 

require numeric codes, Tally pioneered the ‗no accounting codes‘ concept. 

Tally users have the freedom to allocate meaningful names in plain English to 

their data items in the system.   

Complete business solution: Tally provides a comprehensive solution to the 

accounting and inventory needs of a business. The package comprises 

financial accounting, book-keeping and inventory accounting. It also has 

various tools to extract, interpret and present data.   

Integrated/Non-integrated accounting and inventory: With Tally, the user 

is able to choose to maintain accounts only. If accounting with inventory is 

opted for, the user can choose whether it should be integrated or not.  Flexible 

and easy to use: Tally is very flexible. It mimics the human thought process, 

which means that Tally can adapt itself to any business need. Tally users 

need not change the way their business is run to adapt themselves to the 

package.   

Speed: Tally provides the capability to generate instant and accurate reports, 

which assist the management to take timely and correct decisions for the 

overall productivity and growth of the company.   

Power: Tally allows the user to maintain multiple companies and with 

unlimited levels of classification & grouping capabilities. It also allows drill 

down facility from report level to transaction level.   

Flexibility: Tally provides flexibility to generate instant reports for any given 

period (month/year) or at any point of time besides providing the facility to 

toggle between Accounting & Inventory reports of the same company or 

between companies.   

Concurrent multilingual capability: Tally offers you the exclusive capability 

of maintaining your accounts in any Indian language, viewing them in another 

language and printing them in yet another Indian language 
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Real time processing: Immediate posting & updation of books of accounts as 

soon as the transactions are entered, thereby facilitating instant statements & 

Reports. It also faciliates a real-time multi-user environment.   

Versatility: Tally.ERP9 is suitable for a range of organisations, from small 

grocery stores to large corporations with international locations and 

operations.   

Multi-platform availability: Tally is available on multiple versions of windows. 

It runs on a single PC or on a network. On a network, it supports access via 

any combination of platforms.  

Online Help: The Tally Online Help (Alt+H) provides instant assistance on 

basic and advanced features or any other relevant topics of Tally. 

BOOKKEEPING : 

‗Bookkeeping‘ is one of the functions of financial accounting. Bookkeeping 

entails maintaining proper records and books for recording complete details of 

transactions made during the course of business. Business transactions can be 

classified into several major activities/groups e.g. sales, purchases, assets, etc. 

Separate books for recording transactions pertaining to these activities are 

maintained, registering in them the details of respective transaction. This 

exercise is called Bookkeeping. 

Accounting  

Transactions involve ‗accounts‘. Each transaction has to be done through an 

‗account‘. There are total three types of accounts:  

i. Personal Account or Individual account: This group of accounts 

includes all accounts of individuals and organisations like a firm, a 

corporate entity, a society, etc.  

ii. Assets Account: This group of accounts covers all types of assets. 

Assets mean all those investments made in tangible or intangible form 
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of assets, which have utility value or use value. Moreover, these 

assets can also be disinvested and converted into cash. I 

iii. Income-Expenditure Account: This group of accounts encompasses all 

accounts, which represent revenue income and revenue expenditure 

of the business. 

 

 

 

Creation of a Company in Tally.ERP 9: 

The first step towards working with Tally.ERP 9 is to create a ‗company‘. A 

‗company‘ in Tally.ERP 9 is a central repository where you can maintain all the 

financial records of your business, and from where you can extract the 

required financial reports and statements.  The procedure to create a company 

is explained below. To facilitate easier understanding, we have illustrated the 

creation of a company named Vridhi Traders:  

1.2.1 Go to Gateway of Tally > Company Info. > Create Company The 

Company Creation screen appears as per Figure: 
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The fields in the company creation screen and the information to be filled in 

each of them are explained below. To navigate between the fields, use the 

Enter/Tab/Arrow Keys, or Mouse clicks.   

Directory: The path to the location of Tally.ERP 9 data is displayed here. By 

default, the path provided while installing Tally.ERP 9 will be displayed. 

However, you can press backspace and specify the location in which you want 

the data to be stored.  

Name: Provide a name for the company that is being created. In this example, 

we are creating a company named Vridhi Traders.   

Primary Mailing details: The mailing name and address details are picked 

from here for any report such as balance sheet and statements of accounts.   

Mailing Name: The name provided for the company in the name field is 

automatically displayed here. However, you can change it as per 

requirements. The name specified here will be used for mailing purposes. In 

this example, Vridhi Traders is retained.   

Fill in the company‘s address. 

Country: Select the country in which the company is located. This will allow 

users to choose the statutory capabilities available for that country. In this 

example, the country selected is India.   

Fill in the relevant numbers in the Telephone No. and Mobile No. fields.   

E-Mail: Fill in the company‘s official e-mail ID here. This will be used while e-

mailing reports and statements from Tally.ERP 9. 

 

Books and Financial Year Details:   

Financial Year from: This refers to the twelve-month accounting period of the 

company. For Vridhi Traders, the financial year begins on 1-7-2016.   

Books beginning from: The date provided in the aforesaid field will be 

automatically displayed here. In the example, the date is retained. However, if 

you have started with maintaining your books of accounts with Tally.ERP 9 

mid-year, the required date can be set accordingly. Tally will not allow you to 
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record the transactions for dates preceding the date entered in the books 

beginning from field. 

Security Control:  TallyVault Password (if any): Once you enter a password 

here, you will need it to open your company each time. The name of a 

company that is locked using TallyVault will be hidden with the asterisk ‗*‘ 

symbol. You need to provide the TallyVault password to open and access the 

company.  Repeat Password: Here, enter the password entered in the 

TallyVault field, as a confirmation.  Use Security Control?: Setting this option 

to Yes will allow you to define the access rights for each user who will access 

your company. 

Base Currency Symbol: The base currency symbol will be filled as per the 

country selected.   

Formal Name: The currency‘s formal name will be filled here. In this example, 

it is INR (Indian Rupees)   

Suffix Symbol to Amount: For some countries, the currency symbol is 

specified after the amount. This option can be enabled for such countries, so 

that the currency symbol may be printed after the amount. However, Vridhi 

Traders is an Indian company and hence this option is set to No.   

Add Space between Amount and Symbol: Tally.ERP 9 will provide a single 

space between the amount and the currency symbol, if this option is set to 

Yes. For e.g.: KSh 5,000. Notice the space between symbol and the amount.   

Show amounts in Millions: If the company‘s financial statements need to have 

their values expressed in terms of millions, set this option to Yes. Getting 

Started with Tally.ERP 9   

Number of Decimal Places: By default, the number of decimal places for the 

base currency is set to 2. However, you can have up to 4 decimal places. The 

Indian currency has 2 decimal places whereas certain other countries require 3 

decimal places and so on.   

Word representing amount after decimal: The symbol for amounts expressed 

in decimals will be set by default. For India, it is Paise.  Decimal Places for 
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printing amounts in Words: You can specify the number of decimal places for 

printing the amount in words. This number should be equal to or lesser than 

the number specified in number of decimal Places field. For example, if the 

currency has up to 3 decimal places, the value to be printed in words can be 

restricted to 2 decimal places. 

The Completed Company Creation screen appears as per Figure 1.2 

 

 

 

Figure 1.2 Company Creation screen of Vridhi Traders 

The message Accept? Yes or No will be displayed. 

Press Y or Enter to save the details. 

Notice that Indus Enterprises is highlighted. This indicates that it is the 

currently selected company from the list of open companies. You can click on 

the name of another company to make it as the currently open company.  

Select a Company: 

By ‗selecting‘ a company, you are essentially opening the company it in 

Tally.ERP 9.  

1. Go to Gateway of Tally > F3: Company Info. (Alt+F3)  

2. Click Select Company, or press S. Tally.ERP 9 displays the Select Company 

screen, with a List of Companies that are available in the location specified. 

You can also press F1 to get to the Select Company screen.  
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Shut a Company:  

By ‗shutting‘ a company, you are essentially closing a company.  

Go to Gateway of Tally > F3: Company Info. (Alt+F3)  

1. Click Shut Company. Tally.ERP 9 displays the Close Company screen, with 

the List of Companies that are open. You can also use Alt+F1 from the Gateway 

of Tally to get to this screen. 

Alter Company Details: 

By ‗altering‘ a company, you are modifying the details which you have provided 

in the Company Creation screen.  

Go to Gateway of Tally > F3: Company Info. (Alt+F3)  

1. Click Alter or press A. Tally.ERP 9 displays the Select Item screen, with a 

List of Companies that are available in the location specified. Select the 

company which you need to alter and press Enter to view the Company 

Alteration screen. Alter the company details as required and accept the screen. 

 

Account Group Creation In Tally.ERP 9, 

There are 28 predefined groups, this mean that it is not necessary to create the 

Account Group in Tally.ERP 9. However, considering the different requirement 

of an organisation and its nature, Tally.ERP 9 has also provided flexibility to 

create the account group, if need be.  

Group creation is similar to ledger creation in Tally.ERP 9. As with ledgers, 

there are two ways of creating groups:  

I. Single Group Creation: Involves creation of a single group at a time  

II. Multiple Group Creation: Involves creation of multiple groups at a time 

Single Group Creation The group to be created, and the primary group under 

which it has to be classified, is specified in the table below:  

Group to be created                  Classification  

Debtors – North                         Sundry Debtors  

To create the group,  

1. Go to Gateway of Tally > Accounts Info. > Groups > Create (Single Group)  

2. Enter Name as Debtors - North  
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3. Against the field Under select Sundry Debtors from the List of Groups The 

Group Creation Screen appears as per Figure 1.10 

 

Group Creation — North Debtors Note: To create a Multi Group in Tally.ERP 9, go to 

Gateway of Tally >. Accounts Info > Groups > Under Multiple Groups > Select create. 
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Ledger Creation: 

 In Tally.ERP 9, we can create the ledgers in two ways given below:  

I. Single Ledger Creation: Here we can create one ledger at a time.  

II. Multiple Ledger Creation: Here we can create different ledgers at one 

go and also ledgers which belong to particular group. 

I. Single Ledger Creation:  Creation of Proprietor‘s Capital Account ledger 

from single ledger creation screen.  

1. Go to Gateway of Tally > Accounts Info. > Ledgers > Create (Single Ledger 

Creation)  

2. Enter Name as Proprietor‘s Capital Account  

3. Select Capital Account from the List of Groups The Ledger Creation Screen 

appears as per Figure  Figure Ledger Creation screen — Proprietor‘s Capital 

Account  

 

 

4. Press Y or Enter to accept the screen  

Tally.ERP 9 displays the total debit and credit opening balances in the right 

upper corner of screen while the ledgers are being created in the ledger creation 

screen. This is to avoid differences in the opening balance.  
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III. Multiple Ledger Creation: 

Now let us create the following ledgers using the Multi Ledger Creation option:  

To create Multiple Ledgers at once, follow the below given steps:  

1. Go to Gateway of Tally > Accounts Info > Ledgers > Multiple ledgers > Create  

2. From Under Group field select All Items If you select Purchase Account in 

the ‗Under Group‘ field, then the ledger will be created under Purchase Account 

Head.  

3. Under Name of Ledger enter the name as Kaltronic Ltd Learning Tally.ERP 9  

4. Select as Sundry Creditors from the List of Groups  

5. Press Enter and move to next line as there is no opening balance  

6. Similarly, select the other ledgers as shown in figure 1.9:  

 

Multi Ledger Creation Screen 

 

7 Press Enter or Y to Accept Figure 1.9  

Now that we have learnt how to create ledgers under Tally.ERP 9‘s default pre-

defined groups, let us move on to understand how to make alterations to 

ledgers that are already created.  

Altering and Displaying Ledgers  

Now, go to Gateway of Tally >Accounts Info>Ledgers > Select Display under 

single ledger, you will see that the List of Ledgers.  



V. Elavazhahan, Assistant Professor/Programmer Div. Of comp. & Inf. Sci., A.U   Page 66 
 

You can also Alter ledgers from Accounts Info. > Ledgers > Alter (Multiple 

Ledgers). Deleting Ledgers  

You can delete a ledger, by pressing Alt+D in the Ledger Alteration screen. 

Maintaining Chart of Accounts inTally.ERP 9 You will not be able to delete a 

ledger, once the financial transactions (vouchers) have been entered (excluding 

the Opening Balance). If there is a need to delete a ledger with any financial 

transactions, all the transactions must be deleted first by pressing Alt+D. 

1.4.1.4 Group Creation In Tally.ERP 9, there are 28 predefined groups, this 

mean that it is not necessary to create the A 

 

You will not be able to delete a ledger, once the financial transactions 

(vouchers) have been entered (excluding the Opening Balance). If there is a 

need to delete a ledger with any financial transactions, all the transactions 

must be deleted first by pressing Alt+D. 

 

The ‘Features’ in Tally.ERP 9 

 

The ‘Features’ in Tally.ERP 9 are a set of capabilities, provided as options, 

that enable you to maintain financial records as per your business needs. The 

company features menu can be found by clicking F11: Features on the vertical 

button bar. The effect of these options will be reflected only in the company for 

which they are enabled. 

Features The Company Features section in Tally.ERP 9 is divided into the 

following major categories:   

1. Accounting Features 

2. Inventory Features 

3. Statutory & Taxation  TSS Features 

4. Add-On Features 

Accounting Features : 
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 The Accounting Features consists of configurations/functionalities, which 

generally affect accounting transactions and reports. The Accounting features 

section is further divided into six sub-sections, namely:   

1. General 

2. Outstanding 

3. Management 

4. Cost/Profit 

5. Centres Management 

6. Invoicing 

7. Budgets and Scenario Management 

8. Banking Features 

Inventory Features:  The Inventory features comprise of 

configurations/functionalities pertaining to inventory transactions and reports. 

The Inventory features section is further divided into seven sub-sections, 

namely: Learning Tally.ERP 9   

General 

  Storage & Classification  Order Processing 

  Invoicing 

  Purchase Management 

  Sales Management 

 other Feature 

Statutory & Taxation Features: 

The Statutory & Taxation features comprise of configurations/functionalities 

pertaining to statutory compliances available in Tally.ERP 9. The Statutory 

features are country specific and strictly depend upon the country selected in 

the Company Creation screen. 

TSS Features : 

The Tally Software Services (TSS) screen comprises information about 

Connection, Remote Access and SMS Access details of a company. The TSS 
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Features will be available only when Use Security Control is set to Yes in 

Company creation screen. 

Go to Gateway of Tally > F11: Company Features > TSS Features or click F4: 

TSS 

Add-On Features  

Customers, to meet their accounting requirements, may purchase customised 

solutions from Tally Partners. Depending on the customer requirement, the 

solution provider formulates the solution. In some cases, a solution may 

require the introduction of a new feature in Tally.ERP 9 to support the 

functionality. F6: Add-On Features is a place holder for the features provided 

in the Add-ons/Local TDLs loaded. Go to Gateway of Tally > F11: Company 

Features > F6: Add-On Features  

Data Management and Security Features: 

The data management and security features comprises of 

configurations/functionalities pertaining to:  Taking backup of a company 

  Restoring the backup of a company 

  Splitting a company 

  Exporting and importing data using Tally.ERP 9 

  E-Mailing 

  Data Security 

Payroll Features Tally.ERP 

Tally.ERP 9 integrates payroll features with accounting features, and simplifies 

payroll processing. Tally.ERP 9 enables users to set up and implement salary 

structures, ranging from simple to complex, as per the organisation‘s 

requirements. Users can also align and automate payroll processes and 

integrate the same with other accounting applications. Tally.ERP 9 also 

supports payslip printing, recording of attendance, leave, and overtime. Users 

can also generate gratuity and expat reports. 
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Configurations In Tally.ERP 9, 

 F12: Configurations are provided for Accounting, Inventory & printing options 

and are user definable as per the business‘ requirements. The F12: 

Configurations are applicable to all the companies residing in the Tally.ERP 9 

data Directory. The F12: Configuration options vary depending upon the 

context, i.e., if you press F12: Configure from voucher entry screen, the 

respective F12: Configurations screen is displayed.  

Go to Gateway of Tally > F12: Configure. 
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UNIT IV  
 

Vouchers 
 

Vouchers - Introduction  

 
In accounting terms, a voucher is a document containing the details of a 

financial transaction. For example, a purchase invoice, a sales receipt, a petty 

cash docket, a bank interest statement, and so on. For every such transaction 

made, a voucher is used to enter the details into the ledgers to update the 

financial position of the company.  

 
Type of Vouchers  

Tally.ERP 9 is pre-programmed with a variety of accounting vouchers, each 

designed to perform a different job. The standard accounting vouchers are:  

1.  Contra Voucher  

2. Payment Voucher  

3.  Receipt Voucher  

4.  Journal Voucher  

5. Sales Voucher/Invoice 

6.  Credit Note Voucher 

7. Purchase Voucher  

 8.Debit Note Voucher  

 

Contra Voucher 

This Voucher is used for fund transfers between Cash and Bank accounts 

only. Like Fund transfer from one Bank / Cash account to another Bank / 

Cash account, Cash Deposit / Withdrawals into/from Bank. 

Debit or Payment Voucher 

A Payment voucher is used to record a payment of cash or cheque. In this case, 

the cash/bank will be credited and there will be an outflow of funds. 
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Credit or Receipt Voucher 

A Receipt voucher is used to record cash or bank receipt. Here there is an 

inflow of funds. Receipt Vouchers are of two types: 

 Cash receipt voucher – It represents receipt of cash in hand 

 Bank receipt voucher – It indicates receipt of a cheque or demand draft 

i.e., money is not received in the form of cash in hand. Instead, the 

money is credited to the bank account of the assessee. 

Journal Voucher 

A journal voucher is a document on which is stored the essential information 

about an accounting transaction. 

Sales Voucher/Invoice 

Introduction Sales Voucher. Sales Voucher is used to record 

the Sales transactions of the company. You can pass an entry using 

the Voucher mode or the Invoice mode where the calculations can be 

automated and the transactions can be fed into the system easily 

Credit Note Voucher 

Credit Note are used for giving credit to the party, for example, when a buyer 

returns the goods (SALE RETURN) or allows himself Credit due to rate 

difference or Discount or Due to some adjustment. 

Purchase Vouchers 

Purchase Vouchers is used when you have to purchase some goods from any 

party and you get an invoice against cash or credit purchase from the party. ... 

While preparing the purchase voucher, the purchase or goods account is 

debited and supplier's account is credited with the value of purchase amount. 
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Debit note voucher 

Debit Note is a document/voucher given by a party to other party stating that 

such other party's account is debited in the books of sender. For example: A 

trader ―ABC‖ purchases goods from ―XYZ‖. After receiving the material, ABC 

founds that the goods contain some defective goods of value of Rs. 10,000. 

Non-cash or Transfer Voucher 

Non-cash vouchers are used for non-cash transactions. They are basically used 

as documentary evidence. e.g., Goods sold on a credit basis. In these cases, the 

cash / bank account of the assesses is not affected. 

Supporting Voucher 

Supporting voucher serves as documentary evidence of the transactions 

happened in the past. For example, you can attach the bill of an expense along 

with the original voucher just to further support the primary voucher. Petrol 

Bills attached to the conveyance vouchers is a good example of Supporting 

Voucher. 

 Feature of voucher  

1. The identification number of the supplier. 

2. The amount to be paid. 

3. The date on which payment should be made. 

4. The accounts to be charged to record the liability. 

5. Any applicable early payment discount terms. 

6. An approval signature or stamp. 

 

What is Bill wise Accounting? 

If we make an entry to a ledger that needs bill wise details, we have to give the 

details of the bill at the voucher entry itself. Where we can see the details of 
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bills, specific credit periods and get the correct outstanding result [balance] of 

each ledger. 

But when there are a lot of entries it becomes difficult to match a payment to 

an invoice. It is so that the details of creditors and debtors are maintained at 

the invoice level and called as Bill-Wise Accounting system. 

Where do we find Bill wise Accounting feature ? 

We find this feature of Bill wise Accounting in Tally.ERP 9 under the 

Accounting feature head (F11 

 Route to Access:  

To enable the accounting features Go to Gateway of Tally > F11: Features > F1: 

Accounts. 

We can now activate Bill wise accounting feature under the heading 

outstanding management features. 

 Bill wise Accounting: 

Enable this option to display the option Maintain balances bill by bill in all 

ledgers created under sundry debtors and creditors. Where we enter the details 

of sales and purchases with the bill wise option activated, Tally.ERP 9 prompts 

us to identify the invoice with an appropriate reference number. 

Types of Bill wise details in Tally.ERP 9 

There are four types of bill wise detail. 

New Reference This is used at the time of passing sales and purchase 

entries which will later serve for Against reference 

entries to be passed under Sundry debtors and 
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creditors ledger. 

Against Reference This reference is used when we pass receipt entries or 

payment entries against the references created at the 

time of passing of original entries such as sales and 

purchase. 

Advance This reference is used when any amount is received in 

advance for any services rendered or for any outward 

supplies of goods is made or when any amount is paid 

in advance for purchases to be made at the future date. 

In other words, this type of bill wise detail is 

maintained where the nature of service or nature of 

product or terms of business demands advance 

receipts/ advance payments to be made and to track 

these when the business gets materialized at the time 

of raising of bill or invoice, these entries would serve as 

reference. 

On Account An interest receipt entry, interest payment entries uses 

these types of references. But apart from these, this 

type of reference is also used when we are unsure of as 

of against which bill the sum has been settled by the 

debtor. 

So, all those types of entries are kept under this 

reference till the time it gets cleared as to which Invoice 

the sum relates to. 

 

Benefits of maintaining Bill wise details in Tally.ERP 9 
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 To easily maintain/generate outstanding reports of Receivables and 

Payables 

 To maintain & track Accounts Receivable and Accounts Payable based on 

every bill 

 The primary benefit of this capability is the speed and ease which is 

enabled by Tally.ERP 9 

 Helps in generating Age wise analysis report for receivables and payables 

How to activate Bill wise Accounting in Tally.ERP 9? 

It just takes few steps to activate this feature in Tally.ERP 9 

Step 1: To set Maintain Bill wise Details to Yes in F11 : Accounting 

Features window 

Step 2 : To create a Party (Ledger A/c) under Sundry Debtors / Sundry 

Creditors group 

Step 3 : To set maintain balances bill by bill to Yes for the parties 

during ledger creation 

Step 4 : From Gateway of Tally > Accounting Vouchers > Sales (F8) or 

Purchase (F9) accordingly and enter the transaction by 

specifying a Bill reference No. along with due dates for the 

amount to be received or paid in the Bill Allocations for screen 

(we can also break up the amount into multiple reference 

numbers with different due dates) 

To generate various types of Bill wise summary report in Tally.ERP 9 

Generally to view Receivables / Payables Reports, we have to proceed to 

Gateway of Tally > Display > Statement of Accounts > Outstandings > 

Receivables (to view due to the company). This report displays bill by bill 

outstanding for all the parties with the pending amount along with the due 

date. 
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Report Type Description 

Individual party wise – Bill wise 

outstanding 

 Select Ledger in the Outstandings menu 

 We will now get a report displaying bill-

by-bill details of all outstandings for the 

concerned party along with the total 

outstanding amount 

Group Outstanding report – 

Bill wise outstanding 

To View Group Outstanding Report, select 

Group in the Outstandings menu and then 

select the specific group or sub group 

Ageing analysis report – Bill 

wise outstanding 

 We can also view Ageing Analysis of 

Outstandings, by defining various ranges 

of periods and view outstanding across 

the specified time slabs 

 Such as 0 to 30 days, 30 to 45 days and 

45 to 75 days and so on 

 To View Ageing Analysis Report , go to 

Gateway of Tally  > Display  > 

Outstandings  > Receivables or Payables 

 Select F6 (Age wise) 

 Specify Ageing Methods and the Periods 

 

Bill wise accounting for Non – Trading accounts 

Maintaining details of every bill for trading accounts is possible in Tally.ERP 9 

using Bill wise Details. The same powerful and convenient feature is available 

for tracking and managing non- trading accounts like Loans, Advances and 

Installment Payments etc. as well. 

https://tallysolutions.com/tally-a-z/ledger-creation-in-Tally-ERP-9
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Using this feature, business owners can easily track bills for expenses, any 

installments to be paid or loan amounts to be received. ‗Bill wise Details‘ hence 

can be used to track the details of any already made or due payments and also 

to generate payables or receivables reports with minimum effort. 

Internet computations 

Import/Export of data: Any transaction can be exported and imported to 

other software after suitably altering the current structures to accept the 

Tally.ERP 9 data structure. Data can also be imported to Tally. ERP 9 by 

writing a TDL program. The data which is to be exported from Tally.ERP 9 can 

be in XML, HTML or ASCII format.  

Data Synchronization: Synchronization is the process of exchanging 

Tally.ERP 9 data between two or more locations. This process enables a branch 

office to send its data to the head office, over the Internet or a private network.  

Graphical analysis of data: Tally.ERP 9 provides graphical analysis of data 

which helps the user to perform deeper analysis. The user can generate 

graphical analysis reports such as Sales register, Purchase register, Ledgers, 

Funds flow, Cash flow, Stock Item registers and so on. This helps the 

management to quickly judge performance and be better prepared for difficult 

times.  

ODBC (Open Database Connectivity) compliance: It allows other programs to 

use data from Tally.ERP Thus, any program such as MS-Excel or Oracle, which 

is ODBC compliant, can use data from Tally.ERP 9. Data connectivity is 

dynamic, which means that any update in Tally.ERP 9 is reflected in real time 

in other ODBC compliant software. The user can also extract data from 

Tally.ERP 9 and design his/her own report formats in other ODBC compliant 

software.  

Protocol support: Tally.ERP 9 provides protocol support for HTTP, HTTPS, 

FTP, SMTP, ODBC and raw sockets with data interchange formats such as 

XML, HTML with XML islands, SOAP and related formats. Protocol refers to a 
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mecha- nism by which information (data) can be put into or taken from 

Tally.ERP 9. Formats refer to the standard for informa- tion to be generated 

from Tally.ERP 9 or from other applications which can exchange data with 

Tally.ERP 9.  

Direct web browser access: While working on Tally.ERP 9, the user can 

directly log on to the Tally website, provided he/she has access to the Internet. 

The website lists details of all the facilities offered by Tally. ERP 9. The user can 

also download the latest release of Tally.ERP 9 as and when it is available. The 

Tally website also offers Tally Chat, by which a user can communicate with a 

Tally representative and get required information.  

Ability to preview and publish reports and documents on the Internet: 

Companies which want to publish reports and price lists on their website can 

do so directly from Tally.ERP 9.  

E-mail Facility: Tally.ERP 9 facilitates the mailing of any Tally.ERP 9 report or 

document.  

Multilingual capability: Tally is the world‘s first accounting and inventory 

software with multilingual capability.  

Currently, Tally.ERP 9‘s multilingual capability extends to 12 languages which 

include nine Indian languages (Hindi, Gujarati, Punjabi, Tamil, Telugu, 

Marathi, Kannada, Malayalam and Bengali), Arabic, Bahasa Melayu and 

Bahasa Indonesia. Tally.ERP 9 enables you to enter data in one language and 

have it transliterated into different languages. You can generate invoices, 

purchase orders or delivery notes in the language of your choice after entering 

data for the same in any of the nine specified languages. Also, the phonetic 

keyboard allows you to spell the term phonetically based on how it sounds and 

Tally.ERP 9 displays the data in the language selected after transliteration.  

Point of Sale (POS): POS is an acronym for Point of Sale. Point of Sale can be a 

retail outlet, a check out counter in a shop, or any other location where a sales 

transaction takes place. It is a computerised cash register which adds up the 

sales totals, calculates the balance to be returned to buyer and automatically 

adjusts the inventory level to reflect the quantity sold. The equipment required 



V. Elavazhahan, Assistant Professor/Programmer Div. Of comp. & Inf. Sci., A.U   Page 79 
 

for POS to work effectively are cash registers, card readers, barcode scanners 

and so on.  

 

DISPLAY ACCOUNT BOOKS AND STATEMENTS 

Books of account 

Books of account record the transaction details as entered. Although items are 

posted too many different ledgers, Tally brings all the transactions of a 

particular category together into a book of account for viewing and printing. 

For example, Cash Book records all the transactions affecting cash and the 

Sales Book records all sales transactions. 

Statement of Accounts 

These pertain to cost centres and outstanding analysis. The Statements of 

Account are derived from individual transactions but are not statutory 

requirements. 

 

 

 

                                  

Financial Statements 

 Financial Statements though derived from individual transaction tend to show 

summary totals, ratios and statistics, analyzing a company‘s financial data in a 

wide variety of ways. Financial statements include Balance Sheet, Profit & Loss 

A/c, and Cash Flow Analysis and form part of the statutory requirements in 

most countries. 

1. All books are displayed as a monthly summary with opening and closing 

balances. 

http://ncsmindia.com/wp-content/uploads/2012/05/50.jpg
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1. Select a month and press Enter to display all transactions for the month. The 

opening and closing balances as well as the total of all transactions are 

displayed. 

1. Select a transaction to bring up the voucher. The voucher displays either in 

alteration mode or simply displays depending on your access rights. 

Let us see some typical examples of how to display the books of account and 

financial statements. You will then be able to experiment with other statements 

for yourself 

VIEWING CASH/BANK BOOKS 

To view the Cash/Bank Summary 
 

 
 

1. Go to Gateway of Tally > Display > Account Books > Cash/Bank Book (s) 

1.  If you have more than one bank account, select one bank account. Press Enter 
to display the Ledger Monthly Summary. 

1. Select F12: Configuration and activate the option Show with Graph to Yes.  

http://ncsmindia.com/wp-content/uploads/2012/05/491.jpg
http://ncsmindia.com/wp-content/uploads/2012/05/481.jpg
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1. Highlight a month, press Enter and the Ledger Vouchers screen displays.

 
1. All the vouchers for the selected month are listed. Press Esc to return to the 

Ledger Monthly Summary screen. 
1. Select F12: Value to bring up the Value to Calculate in Report screen. 

a)      Select Voucher Type from the Particulars menu. 

b)      In the Particulars menu, select Narration. 

c)      In the Range of Info. Menu select equal to. 

d)      Type Contra in the next field and press Enter. 

e)      In the Condition menu select End of List and press Enter twice.

 

1. In the display of the Ledger Monthly Summary the figure are now reduced as 

they show only Contra vouchers. To check this, position th highlight bar over 

the July figures and press Enter to display the details. 

1. Press Esc until you return to the Gateway of Tally menu. 

DISPLAY BALANCE SHEET 

 The Balance Sheet is a report on the status of the financial affairs of a company at a given date. To view Balance 

Sheet: 

Go to Gateway of Tally > Balance Sheet  

Press F12: Configuration and set the required parameters to display the Balance Sheet accounting to yore 

preferences. 

http://ncsmindia.com/wp-content/uploads/2012/05/471.jpg
http://ncsmindia.com/wp-content/uploads/2012/05/461.jpg
http://ncsmindia.com/wp-content/uploads/2012/05/451.jpg
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Note: Balance Sheet gets updated instantly with every transaction voucher that is entered and saved. 

HORIZONTAL FORM OF BALANCE SHEET 

 The Balance Sheet screen is displayed in the Horizontal form. See it in a Vertical form by activating Show Vertical 

Balance Sheet to Yes in F12: Configuration  

Extract information form the Balance sheet using options available in the 

Button Bar. 

1. Select F1: – Detailed/Condensed to explode the summarized information. 

1. Change the date of the Balance Sheet using F2: Period. 

1. Add up new columns and 

1. Display a Balance Sheet for a different date to compare with current one 

1. Display the Balance Sheet in a different currency 

1. Display Budget figures and analyse the variances or 

1. See the effect of different Stock Valuations on the Balance Sheet  

INTERGRATE ACCOUNTS WITH INVENTORY 

Effect on Balance Sheet and Profit & Loss Account 

Integrate Accounts with Inventory in F11: Features has a significant effect on 

the Balance Sheet and Profit & Loss Account. 

 If Accounts with Inventory is set to Yes in F11: Features, it has stock/inventory 

balance figures are updated from the inventory records, which in turn enables 

you to drill down to the Stock Registers from the Balance Sheet. 

http://ncsmindia.com/wp-content/uploads/2012/05/442.jpg
http://ncsmindia.com/wp-content/uploads/2012/05/432.jpg
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 If the option Accounts with Inventory is set to No in F11: Features, the 

inventory books figures are ignored and closing stock balances are entered 

manually. 

Note: Stock records often contain compensating errors caused by wrong 

allocation to items. This feature of Tally enables the finalization of financial 

books without waiting for reconciliation of stock that might take time. 

DISPLAY PROFIT & LOSS ACCOUNT 

The Profit and Loss Account shows the operational results over a given period. 

It lists out the Incomes and Expenditures based on the Primary Groups of Tally 

and the Profit & Loss Account in Tally is updated instantly with every 

transaction voucher that is entered and saved. 

To view the Profit & Loss Account 

Go to Gateway of Tally > Profit & Loss Account  

Note: The Profit & Loss Account is displayed according to the configuration set 

up for it in F12: Configure. 

HORIZONTAL FORM OF PROFIT & LOSS ACCOUNT 

The sample screen shown is in horizontal form which is the default display. 

You can also set it up to display in vertical form. 

Using options in the Button Bar 

1. Select F1: Detailed/Condensed to display more information or condense. 

1. Change the date of the Profit & Loss Account using F2: Period. 

1. Add new columns to 

1. Display a Profit & Loss Account for a diffe3rnet period to compare with the 

current one 

1. display the Profit & Loss Account in a different currency 

1. Display a column with Budget figures and analyse variances 

1. See the effect of different Stock Valuations on the Profit/Loss account. 

http://ncsmindia.com/wp-content/uploads/2012/05/422.jpg
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1. Select and compare Profit & Loss of different companies. 

 

INCOME/EXEPENSE STMT INSTEAD OF P&L? 

Account statements for Non-Trading Organizations 

For Non-Trading accounts (e.g. Accounts of Charitable Organizations), the 

Trading and Profit & Loss Statement are inappropriate. 

In such cases, you may use Income & Expenditure Account by setting 

Income/Expense Stmt instead of P&L to Yes in F11: Features. 

The Income & Expenditure Statement displays as shown.  

DISPLAY TRIAL BALANCE 

 Trial Balance is a report of all account balance for the company sorted by 

groups, i.e., it is displayed in a grouped form, comprising main groups and 

their closing balances. You can see that the debit and credit balance match. 

In Tally, the matching of the Trial Balance is a foregone conclusion since all 

voucher entries are in Debit – Credit format and must balance at the entry 

point 

To view the Trial Balance 

Go to Gateway of Tally > Display > Trial Balance 

Note: As per accounting principles, the Trial Balance does not list Closing 

Stock.  

 Select F1: Detailed to break down the grouped information or simply drill down 
a Group of further detail. 

http://ncsmindia.com/wp-content/uploads/2012/05/412.jpg
http://ncsmindia.com/wp-content/uploads/2012/05/402.jpg
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The screen appears as shown  

 Select F5: Led-wise to list all ledgers and their closing balances. 

The screen appears as shown  

 Select New Column to bring up the closing balances for another date 

The screen appears as shown  

DAY BOOK 

To view Day Book 

Go to Gateway of Tally > Display> Daybook 

The Day Book lists all transactions made over a particular day and by default 

displays the last voucher entry date of a regular voucher. It could also be set 

up to list all the transactions made over a period. 

Press F2: Period on the button bar or press the keys Alt+F2. 

All the transactions include all financial vouchers, reversing and memorandum 

journals as well as inventory vouchers. 

Consider an example: 

Day Book for current date  

Day Book for a period 

http://ncsmindia.com/wp-content/uploads/2012/05/393.jpg
http://ncsmindia.com/wp-content/uploads/2012/05/383.jpg
http://ncsmindia.com/wp-content/uploads/2012/05/376.jpg
http://ncsmindia.com/wp-content/uploads/2012/05/364.jpg
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You can also filter the list so as to display the transactions of a particular 

voucher type using F4: Chg Vch button from the button bar. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://ncsmindia.com/wp-content/uploads/2012/05/354.jpg
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The screen appears as shown:  

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://ncsmindia.com/wp-content/uploads/2012/05/346.jpg
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UNIT V  

REPORTS 

Stock Categories 

Stock Category offers a parallel classification of stock items. Like stock Groups, classification is done 

based on similarity in behaviour. 

For example, 

Stock Item Sub Group Main Group Sub-Category Main Category 

Brand A - 19” LED TV Brand A Grade One LED TV Television 

Brand A - 17” Smart TV Brand A Grade One Smart TV Television 

Brand B - 19” LED TV Brand B Grade Two LED TV Television 

Brand B - 17” Smart TV Brand B Grade Two Smart TV Television 

The advantage of Categorizing items is that you can classify the stock items (based on functionality) 

together – across different stock groups which enables you to obtain reports on alternatives or substitutes 

for a stock item. 

For enabling Stock Category option in the Inventory Info menu, press F11 > Inventory Features > 

Set Yes for Maintain stock categories . 

On this page 

Create a single Stock Categories 

Create Multiple Stock Categories 

Display a single Stock Category 

Display multi Stock Category 

Alter a single Stock Category 

Alter Multiple Stock Categories 

Create a single Stock Categories 

This option allows parallel classification of stock items. Like Stock Groups, Stock Categories are also 

classified based on some similar behaviour. This enables you to obtain reports for alternatives or substitutes 

of a stock item. 

1. Go to Gateway of Tally > Inventory Info. > Stock Categories > Create (under Single Stock 

Category). The Stock Category Creation screen is displayed as shown below: 

https://help.tallysolutions.com/docs/te9rel66/Creating_Masters/Inventory_Info/#stock-categories
https://help.tallysolutions.com/docs/te9rel66/Creating_Masters/Inventory_Info/#multi-stock-category
https://help.tallysolutions.com/docs/te9rel66/Creating_Masters/Inventory_Info/#display-stock-category
https://help.tallysolutions.com/docs/te9rel66/Creating_Masters/Inventory_Info/#display-multi-stock-category
https://help.tallysolutions.com/docs/te9rel66/Creating_Masters/Inventory_Info/#alter-stock-category
https://help.tallysolutions.com/docs/te9rel66/Creating_Masters/Inventory_Info/#alter-multi-stock-category
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2. Enter the Name of the Stock Category. 

3. Specify whether it is a primary category or a sub-category of another category in the 

field Under. Select Primary from the list, if you do not have a parent group. Use Alt +C to create a 

parent if you do not have the required category in the list. 

 

4. Press Enter to save. 

Button options for single stock category creation screen 

Buttons Short Cut Keys Description and Use 

G: Groups Ctrl+G Allows you to Create a Stock Group. 

I: Items Ctrl+I Allows you to Create a Stock Item. 

U: Units Ctrl+U Allows you to Create a Unit of Measure. 

O: Godown Ctrl+O Allows you to Create a Godown 

V: Vch Types Ctrl+V Allows you to Create a Voucher Types 

Note: Few buttons appear only if you enabled the feature in F11: Features . 

Create Multiple Stock Categories 

Tally.ERP 9 allows you to create Stock Categories using single or multiple options. 

1. Go to Gateway of Tally > Inventory Info. > Stock Categories > Create (under Multiple Stock 

Category). The Multiple Stock Category Creation screen is displayed as shown below: 

 

2. The field Under Category will display the List of Categories . You can select a category for which a 

multiple sub-category can be created. 
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3. If you select All Items in List of categories , selection of parent category Under column is possible 

during creation of sub-category. 

4. If you select specific category in List of Categories , that category will get populated automatically 

whenever creation of sub-category and cursor skips Under column. 

5. Specify the name of the Stock Category . 

6. If you have select All Items in Under Category , you must specify a parent category in this column. 

Button options for Multi Stock Category screen 

Buttons Short Cut Keys Description and Use 

F4: Parent F4 Allows you to change the parent for all Categories. 

G: Groups Ctrl+G Allows you to Create a Multi Stock Group. 

I: Items Ctrl+I Allows you to Create a Multi Stock Item. 

O: Godown Ctrl+O Allows you to Create a Multi Godown 

Display a single Stock Category 

You can display the existing Stock Category in Single mode and multiple mode, since it is only display 

Tally.ERP 9 does not allow you to alter any information in display mode. 

1. Go to Gateway of Tally > Inventory Info. > Stock Categories > Display (under Single Stock 

Category). 

2. Select the Category for which you want to view the display details from the List of 

Categories . The Stock Category Display screen shows the details entered in Stock Category Master. 

 

Button options in single stock Category Display mode 

Buttons Short Cut Keys Description and Use 

G: Group Ctrl+G Allows you to Display a Stock Group. 
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I: Item Ctrl+I Allows you to Display a Stock Item. 

U: Units Ctrl+U Allows you to Display a Unit of Measure. 

O: Godown Ctrl+O Allows you to Display a Godown. 

V: Vch Types Ctrl+V Allows you to Display a Voucher Types 

Note: Few buttons appear only if you enabled the feature in F11: Features . 

Display Multiple Stock Categories 

1. Go to Gateway of Tally > Inventory Info. > Stock Categories > Display (under Multiple Stock 

Categories ). 

2. Select the Stock Category from the List of Categories . 

 

If you select All Items from the List of Groups , all the categories and sub categories are displayed. 

 

If you select Monitor from the List of Categories , all the sub categories related to Monitor will be 

displayed. 
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Button options in multi stock group Display mode 

Buttons Short Cut Keys Description and Use 

F4: Parent Ctrl+F4 Allows you to Display a Stock Group. 

G: Groups Ctrl+G Allows you to Display a Stock Item. 

I: Items Ctrl+I Allows you to Display a Unit of Measure. 

O: Godown Ctrl+O Allows you to Display a Godown. 

 

 

Preparation of Final Accounts 

 

The preparation of a final accounting is the last stage of the 

accounting cycle. It determines the financial position of the business. Under 

this, it is compulsory to make a trading account, the profit and loss account, 

and balance sheet. 

 

Usually, a final account includes the following components − 

 Trading Account 

 Manufacturing Account 

 Profit and Loss Account 

 Balance Sheet 

 

a. Trading accounts  

represents the Gross Profit/Gross Loss of the concern out of sale and 

purchase for the particular accounting period. 

b. Manufacturing Account 

Manufacturing account prepared in a case where goods are manufactured by 

the firm itself. Manufacturing accounts represent cost of production. Cost of 
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production then transferred to Trading account where other traded goods also 

treated in a same manner as Trading account. 

c. Profit and Loss Account 

Profit & Loss account represents the Gross profit as transferred from Trading 

Account on the credit side of it along with any other income received by the 

firm like interest, Commission, etc. 

Debit side of profit and loss account is a summary of all the indirect expenses 

as incurred by the firm during that particular accounting year. For example, 

Administrative Expenses, Personal Expenses, Financial Expenses, Selling, and 

Distribution Expenses, Depreciation, Bad Debts, Interest, Discount, etc. 

Balancing figure of profit and loss accounts represents the true and net profit 

as earned at the end of the accounting period and transferred to the Balance 

Sheet. 

d. Balance Sheet 

A balance sheet reflects the financial position of a business for the specific 

period of time. The balance sheet is prepared by tabulating the assets (fixed 

assets + current assets) and the liabilities (long term liability + current 

liability) on a specific date. 

Preparation of Ratio 

Ratio analysis is a quantitative method of gaining insight into a company's 

liquidity, operational efficiency, and profitability by comparing information 

contained in its financial statements. 

Examples of Ratio Analysis Categories 

Most investors are familiar with a few key ratios, particularly the ones that are 

relatively easy to calculate and interpret. Some of these ratios include the 

current ratio, return on equity (ROE), the debt-equity (D/E) ratio, the dividend 

https://www.investopedia.com/terms/d/debtequityratio.asp
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payout ratio, and the price/earnings (P/E) ratio. While there are numerous 

financial ratios, they can be categorized into six main groups based on the type 

of analysis they provide. 

1. Liquidity Ratios 

Liquidity ratios measure a company's ability to pay off its short-term debts as 

they come due using the company's current or quick assets. Liquidity ratios 

include the current ratio, quick ratio, and working capital ratio. 

2. Solvency Ratios 

Also called financial leverage ratios, solvency ratios compare a company's debt 

levels with its assets, equity, and earnings to evaluate whether a company can 

stay afloat in the long-term by paying its long-term debt and interest on the 

debt. Examples of solvency ratios include debt-equity ratio, debt-assets ratio, 

and interest coverage ratio. 

3. Profitability Ratios 

These ratios show how well a company can generate profits from its operations. 

Profit margin, return on assets, return on equity, return on capital employed, 

and gross margin ratio are all examples of profitability ratios. 

4. Efficiency Ratios 

Also called activity ratios, efficiency ratios evaluate how well a company uses 

its assets and liabilities to generate sales and maximize profits. Key efficiency 

ratios are the asset turnover ratio, inventory turnover, and days' sales in 

inventory. 

5. Coverage Ratios 

These ratios measure a company's ability to make the interest payments and 

other obligations associated with its debts. The times interest earned ratio and 

the debt-service coverage ratio are both examples of coverage ratios. 

https://www.investopedia.com/terms/l/liquidityratios.asp
https://www.investopedia.com/terms/s/solvencyratio.asp
https://www.investopedia.com/terms/p/profitabilityratios.asp
https://www.investopedia.com/terms/t/tie.asp
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6. Market Prospect Ratios 

These are the most commonly used ratios in fundamental analysis and include 

dividend yield, P/E ratio, earnings per share, and dividend payout ratio. 

Investors use these ratios to determine what they may receive in earnings from 

their investments and to predict what the trend of a stock will be in the future. 

GST application 

Enabling GST features in Tally 

1. Go to Gateway of Tally > F11: Features > F3: Statutory & Taxation 

2. In the screen you will find following options : 

3. Enable goods and service tax (GST): Yes 

1. Set/alter GST Details: Yes. 

 This will display another screen where you can set GST details of the 

company such as the state in which company is registered, registration 

type, GSTIN number etc. 

 Press Y or Enter to accept and save. 

How to Activate GST in Tally | Enable GST in Tally.ERP 9 

How to activate GST in Tally ERP 9 

To use GST (Goods and Services Tax) features in Tally, it is mandatory to 

enable or activate GST in Tally. After activation of GST feature in Tally.ERP 9, 

all the GST related features are available for all general ledgers, stock items 

and transactions in Tally. 

Refer below step by step procedure to activate GST in Tally. 

https://www.tutorialkart.com/tally/what-is-tally/
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Step 1: From Gateway of Tally, click on F11: Features or press function 
key F11.

 

 

Step 2: Under company features options, choose Statutory & Taxation or 
press function key F3. 

 

 

Step 3: In next screen company operation alteration, enter the following 
details. 

 Enable Goods and Services Tax (GST: Yes 
 Set/alter GST details: Yes 
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Step 3: When you enable “Yes” for Set/alter GST details, the following screen appears. 

 

Step 4: Now you need to update all the required details of GST. 
 State: It automatically displays state name based on the state you have 

updated in company. 

 Registration Type: Choose GST registration type as ―Composition‖ or 
―Regular. 

 GSTIN/UIN: Update the Goods and Services Tax India (GSTIN) number, 

this GSTIN can be printed on invoices. 
 Applicable from: Enter the date that GST will be applicable from for 

transactions. 
 Periodicity of GST: Enter the periodicity of GST as Monthly or Quarterly 

as per requirements of company. 

 e-Way bill applicable: Choose this option as ―Yes‖ 
 Applicable from: Enter the date that e-way bill to be applicable 

from 
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 Threshold limit includes: It can be based on invoice value / taxable 
and exempt goods value / taxable goods value 

 Threshold limit: Enter the amount value of threshold limit allowed 
 Applicable for intrastate: Choose option as ―Yes‖, if it is applicable 

to your state 
 Threshold limit: Enter threshold limit for intraste 

 Enable tax liability on advance receipts: Choose ―Yes‖ to activate tax 

liability on advance receipts 
 Set/alter GST rate details: Choose Yes to set or alter GST rate details at 

company level. 

 Enable GST classifications: Choose Yes to activate GST classifications. 

 

After entering all the required details for activation of GST in Tally, choose 
―Yes‖ to accept the data and save the details in Tally. 
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Configuring For Printing 

The printing configuration available in Tally.ERP 9 helps you customise your 

reports. You can enable or disable options in the General 

Printing Configuration screen, as required. The configurations set here are 

applicable to all reports and vouchers in Tally.ERP 9. 

To view the general printing configuration screen 

1. Go to Gateway of Tally > click F12: Configure > Printing > General . 

The General Printing Configuration screen appears as shown below: 

 

2. Enable the option Print date and time of report? to print the date and 

time in the reports. 

3. Enable the option Print date and time of voucher printing? to print 

the date and time in the vouchers. 

4. Enable the option Print country, state and Pincode with address? , if 

required. 
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5. Disable the option Stop printing vertical lines and borders? to print 

vertical lines and borders in the reports and vouchers. 

6. Enter the required margin space in the print report in the field Page 

margin on top (in inches) . 

7. Enable the option Print using Greyscale on Black & White printers? , 

if required. 

8. Enable the option Split long names into multiple lines? for better 

readability. 

9. Enable the option Split long amounts/numbers into multiple 

lines? for better readability. 

10. Enable the option Print party name and address from left margin in 

invoice? , if required. 

11. Press Ctrl+A to save the configuration. 

 

Maintenance tells about Back up – Restoring 

Introduction  

Data on the computer is vulnerable to different types of threats and any data 

lost will be disastrous for the organisation. Hence, there is a need to store data 

at a different location by taking a backup.  

Backup  

Tally.ERP 9 helps users to take back up of one or more companies in a single 

directory. Let us understand the backup feature of Tally.ERP 9 using the 

example of Vridhi Traders.  

To take a single or multiple company data backup,  

1. Go to Gateway of Tally > Company Info. > Backup  

2. Enter Source and Destination of the backup  
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3. Press Enter and the List of Companies available for backup will appear. 

Select the required companies for which data backup needs to be created 

4. Once the required companies are selected, select End of List and 

accept the screen. The backup file is  

5. TBK900.001 is stored in the D drive. The same file can be restored as and 

when required.  

Note  

Select All items from the list of companies, if you want to take a backup of all 

the companies at one shot  

Restoring Data from a Backup File  

The Restore functionality allows you to restore the data backup taken earlier. 

Remember the following points before restoring data backup.  

1. Do not restore old or irrelevant data.  

2. Do not restore data from a damaged media.  

3. Do not restore data in the same folder as the existing data, since it may 

overwrite the existing data.  

1. For restoring data from a backup file, follow the steps given below: 

created with the name TBK900.001, as shown in the following Figure 1.18 

1. Go to Gateway of Tally > Company Info. > Restore, you will get the following 

2. Destination field: Enter the folder path where data backup needs to be 

restored.  

3. Source field: Enter the folder path where data backup file or auto backup 

files for multiple companies are stored. The path specified can be on the same 

storage device/external storage device or a storage device on the network.  

4. Select the required companies from the list of companies and then 

restore  

5. Select End of List to complete the selection and accept the screen  
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Rewrite Corrupted Tally Data 

Tally is the most widely used accounting software in India, and data corruption 

is a common problem mainly caused due to power failure, unexpected system 

shutdown, virus attacks, media corruption, OS corruption, or hard drive 

crashes. Since Accounting data is very important for its users, we provide the 

steps to recover such corrupted data. 

Usually when Tally data gets corrupted you are shown an error message 

similar to this: 

―Exiting Tally, 

File Damaged 

File: ‗C:/Tally/Data/0001/Tr08236.500′ 

Size;- 43126 

Possition; 42780 

Char;-128 (Done 128)‖ 

or 

Existing Tally 

Internal Error contact Tally Solutions 

File ‗‖iocl\tally 9.0 \data \10002\Tmessage . TSF 

Size =0 

Char 517 (done 0) 

If you receive an error similar to above then there are very strong chances of 

recovering your data loosing only last few transaction entries. For recovery 

from such situations Tally provides an easy company rewriting option, which 

checks data files for valid entries and recreates the company profile with all the 

valid data it can recover. To use simply follow the instructions below, it is 

always better to make a backup of your Tally data folder before attempting any 

recovery process: 

Step 1: 

Start Tally and go to Company Selection Screen. 

Step 2: 
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Now use Ctrl + Alt + R key combination to launch the Company Rewrite utility. 

Step 3: 

Select the corrupt company profile (usually the one you were working last) and 

press Enter to start the rewrite process. 

Creating Users and Passwords 

You can create users, assign security levels, restrict/allow remote access and local TDLs for the users created. 

To create the user and assign a password execute the following steps: 

1. Go to Gateway of Tally > F3: Company Info > Security Control 

2. Select Users and Passwords 

The List of Users for Company screen appears as shown below: 

 

3. Select the required Security Level from the Security List . 

4. Enter the user‘s name in the Username field. 

5. Enter the password in Password (if any) field. 

6. By default Allow Remote Access and Allow Local TDL is set to No and 
skipped for users not classified under Tally.NET User and Tally.NET 

Auditor 
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7. Accept to create the user. 

Bank Reconciliation 

Bank Reconciliation Statement is an explanation of the difference between 

bank balance as per cash book and bank balance as per Passbook (Bank 

statement). Sometimes, the bank balance as per cash book and pass book do 

not tally with each other, then we can know the difference between them by 

preparing the bank reconciliation statement. 

The process of checking the differences between a bank column of the cash 

book and the bank statement or passbook is called Bank reconciliation process 

in accounting terms. The person preparing BRS Statement has to check all the 

transaction recorded in the cash book with transactions recorded in passbook 

by the bank. 

How to activate auto bank reconciliation in Tally.ERP 9? 

Starting Point : Gateway of Tally 

Destination    : Banking Configuration 

Step 1 Open the bank ledger (in case the Bank ledger is not opened) 

by creating a bank ledger or use  the option ―alter the ledger‖ (if 
bank ledger is already created in Tally) 

Step 2 Under banking configuration, set ‗Yes‘ to use this feature of 
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Auto bank reconciliation in Tally. ERP 9 

Step 3 Select the relevant bank from the ‗List of Banks‘ 

Step 4 After selecting the bank from the list of banks, In the next 
dialogue box, Set ‗ Yes‘ to ‗Activate Auto Reconciliation‘ 

Step 5 Accept the change by selecting  ―Yes‖ in the next screen 

Using auto bank reconciliation in Tally.ERP 9 

After enabling the Auto Bank Reconciliation option, now one can go ahead and 
reconcile the bank statement with the company‘s books following these 

directions : 

 Step 1 Go to ‗Gateway of Tally > Banking > Bank Reconciliation‘ 

Step 2 Select the required bank which has to be reconciled from the 
‗List of Bank‘ 

Step 3 On the ‗Bank Reconciliation‘ screen, press ‗B: Bank Statement‘ 
or ‗Alt + B‘ 

Step 4 Specify the ‗Directory‘, where you have saved the downloaded 
bank statement 

Step 5 In case you need to change the ‗File Type‘, you can press 

‗Backspace‘ to select the appropriate ‗File Type‘ for the bank 
statement to be imported 

Step 6 Once you‘ve selected the required ‗File Type‘, select the 

required bank statement file from the ‗List of Files‘, and 
reconciliation will happen automatically. Once the 
reconciliation happens, a ‗Success!!‘ notification will be 

displayed with details like ‗Total Entries in Bank Statement‘, 
number of entries reconciled and ‗Additional Bank Entries‘ 

Step 7 Now press any key and the Bank Reconciliation Statement with 

Imported bank statement details will appear. Now the screen 
will show the reconciled list of entries from the bank statement 
under ‗Amounts not reflected in Company Books‘ 

Step 8 Begin the reconciliation process for entries under Amounts not 

reflected in company books by verifying with the Bank 
Statements obtained from the bank or the Bank book 

maintained by you. 

 

 


